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Abstract

These Application Notes describe the configuration steps required to integrate InVision
Enterprise WFM (iWFM) with Avaya Call Management System using the ODBC interface to
capture ACD call center data from Avaya Communication Manager. The ODBC interface is
used to import splits/skills, Vector Directory Numbers (VDNSs), and agent data into iWFM
periodically. iWFM is a web-based software solution for enterprise-wide workforce
management. It supports the workforce management process from forecasting to scheduling,
optimization, time management and monitoring.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the configuration steps required to integrate InVision
Enterprise WFM (iWFM) with Avaya Call Management System (CMS) using the ODBC
interface to capture ACD call center data from Avaya Communication Manager. The ODBC
interface is used to import splits/skills, Vector Directory Numbers (VDNs), and agent data into
IWFM periodically. iWFM is a web-based software solution for enterprise-wide workforce
management. It supports the workforce management process from forecasting to scheduling,
optimization, time management and monitoring.

InVision Enterprise WFM uses the ODBC interface to access the Informix database in Avaya
CMS to import interval-based call and agent activity data. The data may be imported on an on-
demand basis or automatically at pre-defined intervals. The historical reports that are supported
by iWFM through this interface include a splits/skills report, a VDN report, an agent login/logout
report, and an agent workmode/AUX reason report. These reports can be viewed within the
IWFM Shift Center and OnlineCockpit, or in reports generated by iWFM.

Avaya Call Management Sc=
System (CMS) = =
(192.45.120.50) | —
InVision iWFM
(192.168.199.51)
Avaya S8700 Servers
(192.45.100.60)

Avaya 4600 Series IP
Telephones (Agents)

Simulated PSTN

Avaya G650 Media Gateway
(C-LAN: 192.45.100.70)

Figure 1: InVision Enterprise WFM with Avaya Call Management System
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2. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Equipment Software
évaya 58700 Servers with G650 Media Avaya Communication Manager 4.0.1, load 731.2
ateway
Avaya Call Management System rldaa.h
Avaya 4600 Series IP Telephones 2.8 (H.323)
InVision Enterprise WFM (IWFM) 45.0

3. Configure Avaya Communication Manager

This section provides the procedures for configuring Avaya Communication Manager. The
procedures include the following areas:

Verify Avaya Communication Manager Options.
Administer adjunct CMS release.

Administer IP node names for C-LAN.
Administer IP interface for C-LAN.

Administer data module for C-LAN.

Administer processor interface channel.
Administer measured VDN.

Administer measured Skill.

The detailed administration of contact center devices such as ACD/Skill, VDN, Vector, and
Agents are assumed to be in place. These Application Notes will only cover how to enable
ACD/SKill, VDN, and Agent data to be sent to Avaya CMS.

JAO; Reviewed: Solution & Interoperability Test Lab Application Notes 3 of 46
SPOC 10/29/2008 ©2008 Avaya Inc. All Rights Reserved. InVision-ODBC




3.1. Verify Avaya Communication Manager Software Options

Log into the System Access Terminal (SAT) to verify that the Avaya Communication Manager
license has proper permissions for features illustrated in these Application Notes. Use the
“display system-parameters customer-options” command to verify that the G3 Version field is
set to “V14” on Page 1, as shown below.

display system-parameters customer-options 1 of 11

OPTIONAL FEATURES

Page

G3 Version: V14

Location: 1 RFA System ID (SID): 1

Platform: 6 RFA Module ID (MID): 1
USED

Platform Maximum Ports: 44000 727

Maximum Stations: 36000 239
Maximum XMOBILE Stations: O 0
Maximum OFF-PBX Telephones - EC500: 0O 0
Maximum OFF-PBX Telephones - OPS: 50 8
Maximum OFF-PBX Telephones - PBFMC: 0O 0
Maximum OFF-PBX Telephones - PVFMC: O 0
Maximum OFF-PBX Telephones - SCCAN: O 0

(NOTE: You must logoff & login to effect the permission changes.)

Navigate to Page 6, and verify that the Call Center Release field is set to “4.0”, as shown
below.

display system-parameters customer-options
CALL CENTER OPTIONAL FEATURES

Page 6 of 11

Call Center Release: 4.0

ACD? y Reason Codes? y
BCMS (Basic)? y Service Level Maximizer? n
BCMS/VuStats Service Level? y Service Observing (Basic)? y
BSR Local Treatment for IP & ISDN? n Service Observing (Remote/By FAC)? y
Business Advocate? y Service Observing (VDNs)? vy
Call Work Codes? n Timed ACW? y
DTMF Feedback Signals For VRU? y Vectoring (Basic)? y
Dynamic Advocate? y Vectoring (Prompting)? y
Expert Agent Selection (EAS)? y Vectoring (G3V4 Enhanced)? y
EAS-PHD? y Vectoring (3.0 Enhanced)? n
Forced ACD Calls? n Vectoring (ANI/II-Digits Routing)? y
Vectoring (G3V4 Advanced Routing)? y
Lookahead Interflow (LAI)? n Vectoring (CINFO)? vy
Multiple Call Handling (On Request)? y Vectoring (Best Service Routing)? y
Multiple Call Handling (Forced)? y Vectoring (Holidays)? y
PASTE (Display PBX Data on Phone)? y Vectoring (Variables)? n
(NOTE: You must logoff & login to effect the permission changes.)
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3.2. Administer Adjunct CMS Release

Use the “change system-parameters features” command and navigate to Page 12. Set the
Adjunct CMS Release field to the software release of the Avaya CMS. In this case, “R14” is
used to correspond to Avaya CMS software release R14.0.

change system-parameters features Page 12 of 17
FEATURE-RELATED SYSTEM PARAMETERS

AGENT AND CALL SELECTION
MIA Across Splits or Skills? y
ACW Agents Considered Idle? y
Call Selection Measurement: current-wait-time
Service Level Supervisor Call Selection Override? n
Auto Reserve Agents: all

CALL MANAGEMENT SYSTEM
REPORTING ADJUNCT RELEASE
CMS (appl mis): R14
CCR (appl ccr):

BCMS/VuStats LoginlIDs? y
BCMS/VuStats Measurement Interval: hour
BCMS/VuStats Abandon Call Timer (seconds):
Validate BCMS/VuStats Login IDs? n
Clear VuStats Shift Data: on-login
Remove Inactive BCMS/VuStats Agents? n

3.3. Administer IP Node Name for C-LAN

Use the “change node-names ip” command, to add entries for Avaya CMS and the C-LAN that
will be used for connectivity. In this case, “cms” and “192.45.120.50” are entered as Name and
IP Address for the Avaya CMS server, and “clan2” and “192.45.100.70” are entered as Name
and IP Address for the C-LAN. The actual node names and IP addresses may vary. Submit
these changes.

change node-names ip Page 1 of 1
IP NODE NAMES

Name IP Address Name IP Address
clan 192.45 .100.66
clan-1a05-AES2 192.45 .100.146
cms 192.45 .120.50
clan2 192.45 .100.70
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3.4. Administer IP Interface for C-LAN

Add the C-LAN to the system configuration using the “add ip-interface 2a02” command. The
actual slot number may vary. In this case, “2a02” is used as the slot number. Enter the C-LAN
node name assigned from Section 3.3 into the Node Name field. The IP Address field will be
populated automatically.

Enter proper values for the Subnet Mask and Gateway Address fields. In this case,
#255.255.255.0” and “192.45.100.1” are used to correspond to the network configuration in these
Application Notes. Set the Enable Ethernet Port field to “y”. Default values may be used in
the remaining fields. Submit these changes.

add ip-interface 2a02 Page 1of 1
IP INTERFACES

Type: C-LAN
Slot: 02A02
Code/Suffix: TN799 D
Node Name: clan2
IP Address: 192.45 .100.70
Subnet Mask: 255.255.255.0
Gateway Address: 192.45 .100.1
Enable Ethernet Port? y
Network Region: 1
VLAN: n

Number of CLAN Sockets Before Warning: 400
Receive Buffer TCP Window Size: 8320
ETHERNET OPTIONS
Auto? y

3.5. Administer Data Module for C-LAN

Add a new data module using the “add data-module n” command, where “n” is an available
extension. Enter the following values, and submit these changes.

= Name: A descriptive name.
= Type: “ethernet”
= Port: Same slot number from Section 3.4 above and port “17”.
= Link: An available link number.
change data-module 24981 Page 1 of 1

DATA MODULE

Data Extension: 24981 Name: Clan2
Type: ethernet
Port: 02A0217
Link: 2

Network uses 1"s for Broadcast Addresses? y
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3.6. Administer Processor Interface Channel

Assign a new processor interface channel with the “change communication-interface processor-
channels” command. Add an entry with the following values, and submit these changes.

= Enable: “y”

= Appl.: “mis”

* Mode: “s” for server mode.

= Interface Link: Link number for data module Ethernet port from Section 3.5.

= Interface Chan: TCP channel number for Avaya CMS. In this case “5001".

= Destination Node: Avaya CMS server node name from Section 3.3.

= Destination Port: “0”

= Session Local:  Corresponding channel number in Proc Chan field. In this case “1”.
= Session Remote: Corresponding channel number in Proc Chan field. In this case “1”.

The Interface Chan field contains the Avaya CMS TCP channel number, which is defined as
part of the Avaya CMS installation. For the compliance testing, the default TCP channel number
of “5001” was used.

change communication-interface processor-channels Page 1 of 24
PROCESSOR CHANNEL ASSIGNMENT
Proc Gtwy Interface Destination Session Mach
Chan Enable  Appl. To Mode Link/Chan Node Port Local/Remote IDnp
1: Yy mis S 2 5001 cms 0 1 1
2: n 0

3.7. Administer Measured VDN

Use the “change vdn n” command, where “n” is the extension of the VDN to be measured by
Avaya CMS. Set the Measured field to “external” or “both” to enable measurement data on the
VDN to be sent to Avaya CMS. Repeat this step for all VDNSs that will be monitored by Avaya
CMS.

change vdn 38000 Page 1 of 2
VECTOR DIRECTORY NUMBER

Extension: 38000
Name*: InVision VDN 1
Vector Number: 380

Meet-me Conferencing? n
Allow VDN Override? n
COR: 1
TN*: 1
Measured: both
Acceptable Service Level (sec): 10
Service Objective (sec): 20
VDN of Origin Annc. Extension*:
1st Skill*:
2nd Skill*:
3rd Skill*:

* Follows VDN Override Rules
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3.8. Administer Measured Skill

Use the “change hunt-group n” command, where “n” is the extension of the ACD/Skill group
number to be measured by Avaya CMS. Set the Measured field to “external” or “both” to
enable real-time measurement data on the ACD/Skill group and the associated agents to be sent
to Avaya CMS. Repeat this step for all ACD/Skill groups that will be measured by Avaya CMS.

change hunt-group 280 Page 2 of 3
HUNT GROUP
Skille y Expected Call Handling Time (sec): 180
AAS? n Service Level Target (% in sec): 80 in 20
Measured: both Service Objective (sec): 20
Supervisor Extension: Service Level Supervisor? y
Activate on Oldest Call Waiting? y
Call Selection Override? n
Controlling Adjunct: none Level 1 Threshold (sec): 50
Level 2 Threshold (sec):
Dynamic Threshold Adjustment? n
VuStats Objective:
Timed ACW Interval (sec): Dynamic Queue Position? n
Multiple Call Handling: none
Redirect on No Answer (rings) :
Redirect to VDN:
Forced Entry of Stroke Counts or Call Work Codes? n
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4. Configure Avaya Call Management System

This section covers the configuration of Avaya CMS to support the import of splits/skills, VDN,
and agent data from InVision Enterprise WFM via the ODBC interface.

Use a terminal emulator to connect to the Avaya CMS server, and log in with the proper
credentials. Enter “cms” at the command prompt to display the MainMenu screen. The first
step is to configure the Current ACD, which in this case is devcon31, an ACD name assigned
on Avaya CMS. From the CMS terminal emulator click on the Commands option button at the
bottom of the screen. Navigate to Options=>Current ACD to specify the current ACD and
press the Enter key.

) Avaya Terminal Emulator - CHS192451 2050 =) O3
Profile  Edit Connection Help
9/24/08 18:49 Avaya(TM) CM3I Windows: 0 of 10 P -

Help Window Cammands Keep Exit Scroll Current kainkden
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In the following screen, set the Current ACD field to devcon31 and then select Modify in the
right pane of the screen. Hit the Enter key. Upon completion, Successful is displayed in the
dialog box as shown in the figure below. Click the Exit button to return to the CMS main menu

=] Avaya Terminal Emulator - CM51924512050

=
=)0t
Profile  Edit Connection Help

9/24/08 18:52 Avaya(TM) CM3

Windows: 1 of 10 Ao

Current ACD

devcoconl8
Find one

duccesstul

Window Commands

Scroll Current tdaintdenu

From the CMS main menu, navigate to Dictionary->Splits/SKills, as shown below, to configure
the splits/skills that will be monitored by iWFM. Hit the Enter key.

& avaya Terminal Emulator - CMS1924512050 M= <
Profile  Edit  Connection  Help
9/24/08

18:41 Awvaya(TM) CM Windows: 0 of 10 T

Help Wincow Commands

keep Exit

Scrall Current kMainkdznu
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The Dictionary: Splits/Skills screen is displayed. Provide a descriptive name for the split/skill

and the number assigned to the split/skill in Avaya Communication Manager (see section

3.8).

Click the Add option in the right pane. Repeat this step for each split/skill to be monitored by

IWFM.

B Avaya Terminal Emulator - CMS1924512050 (=)

Profile  Edit Connection  Help
9/24/08 18:54 Avaya (TM) CMS Windows: 1 of 10 Hapt

Dictionary: Splits/8kills

k11l name:
11 number

Help Sfindow Commands Keep Exit Scroll Current tdainkdenu

Return to the CMS main menu and navigate to Dictionary->VDNs, as shown below, to
configure the VDNs to be monitored by iWFM.

1

|
|| Login Identifications
| ger

Help Winclow Comrmands Keep Exit Scroll Current tainkienu

Avaya Terminal Emulator - CMS1924512050 (=) O ES
Profile  Edit Connection  Help
9/24/08 18:57 Awvaya(TM) CMS Windows: 0 of 10 Hapt -
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The Dictionary: VDNSs screen is displayed. Provide a descriptive name for the VDN and the
extension assigned to the VDN in Avaya Communication Manager (see section 3.7). Click the
Add option in the right pane. Repeat this step for each VDN to be monitored by iWFM.

& Avaya Terminal Emulator - CMS1924512050 =) O3

Profile Edit Connection  Help

9/24/08 18:59 Avaya(TM) CM3I Windows: 1 of 10

Dictionary: VDHN=
VDN name: izion VDN 1

ription:

Winic o Cornmands Scroll Current bainkdenu

Next, agent tracing needs to be enabled for each ACD agent configured in Avaya
Communication Manager to support the agent workmode/AUX reason report in iWFM. From
the CMS main menu, navigate to Agent Administration->Activate Agent Trace and hit the
Enter key.

) Avaya Terminal Emulator - CHS192451 2050 =) O3
Profile  Edit Connection Help
9/z24/08 19:01 Avaya{TM) CM3 Windows: 0 of 10 P -

.

| Agent Admini/ERUINES : |
1 ce 4| Change £ |
3yl ctivate Agent Trace |

Help Window Cammands Keep Exit Scroll Current kainkden
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From the Agent Administration: Activate Agent Trace screen shown below provide the login
agent IDs for each agent and set the Agent trace field to on. Select Modify in the right pane.
Click the Exit button at the bottom of the screen to return to the CMS main menu.

Avaya Terminal Emulator - CMS192451 2050 =)

Profile  Edit  Connection Help
5/24/08 19:03 Avaya(TM) CM3 Windows: 1 of 10

Agent Adwministration: Actiwvate Agent Trace

Agent names or logids: 29101

Whiind ow Commands Scroll Current tainkdenu
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5. Configure InVision Enterprise WFM (iIWFM)

This section provides the procedure for configuring InVision Enterprise WFM for the historical
splits/skills, VDN, and agent reports. There are two agent reports supported, an agent
login/logout report and an agent workmode/AUX reason code report. The procedure includes
the following steps:

JAO; Reviewed:

Configure the ODBC Interface

Configure the Isps_UL . ini File

Administer External System for Avaya CMS

Configure Master Data in iWFM for the Splits/Skills and VDN Reports including:

(0}
0}
(0}
0}

Queues

Value Types

Map Value Types to Queues

Associate the Value Type in iWFM with the data items in Avaya CMS

Configure Master Data in iWFM for the Agent Login/Logout Report including:

0}

O o0O0o

(0]

Planning Unit to group master data

Contracts for employees in call center

Employees for Call Center Agents

Activities for Splits/Skills

Map Activities, Planning Unit, and External System to Employees
Map External System to Activities

Configure Master Data in iWFM for Agent Workmode/AUX Reason Code Report
including:

0}

Activities for Workmodes and AUX Reason Codes
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5.1. Configure the ODBC Interface

This section covers the configuration of the ODBC interface to Avaya CMS. A connection to
the Avaya CMS Informix database is established using an ODBC driver installed on the InVision
Enterprise WFM server. The ODBC client software is supplied with the Avaya CMS software.
To configure the ODBC interface, navigate to Administrative Tools=>Data Sources (ODBC)
in the Windows control panel. The following screen is displayed. Note that the following screen
lists the ODBC interface, which is already configured for Avaya CMS.

€1 ODBC Data Source Administrator

User DSM  Spstem DSM l File DSM ] Drivers] Tracing] Connection F'u:u:uling] About ]

Syztem Data Sources:

M arme | Driver add..
OpenLink Generic 32 Bit Driver

[T_Flight32 Microzoft Accezs Driver [*.mdb’ Bemove

SALServerDnverB#TEMPDSH  SOL Server

#treme Sample Database 2005 Microzoft Access Dnver [“.mdb’

< >

An ODBEC System data zource stores information about how to connect to
the indicated data provider. A Spstem data zource iz vizible to all users
an thiz maching, including MT services.

(1] Cancel Help
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The ODBC interface for Avaya CMS is configured as shown in the figure below.

€ OpenLink ODBC Setup (%)
bulti Tier ADBC Setup Yerzion 4.20
Copyright 1934-2002 Qpenlink Software

Datazource Database
Name: Chis Nare fomz ﬂ
Comment: CWSOL 4.2 Usemarne: I—
OpenLink Server Optional Server [gateway confiqurations anly)

Server Mame
D amain: Informix 2000 -

Others

Protocal: TCRAR

o]

hl ™ Read-only connection

Hostname: 192 45120150 - [ Malogin dislog box

[v Defer fetching of long data

Foit;:
" Ll Bow buffer size: a0

Cancel ‘ ‘ Test Eonnection‘

To test the ODBC connection, click on the Test Connection button in the window above. The
ODBC Login window shown below is displayed. Enter the login credentials for Avaya CMS

and click the Connect button.

€71 OpenLink ODBC Login

Identity ] Database | About |

X

[File DSH]
Usemame:  |cms
Pazgword: ==
Connect | Cancel | Help |

If the ODBC connection is successfully estalished to Avaya CMS, the following status window

is displayed.
Openlink Setup rz|
Connection Successful,
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5.2. Configure the Isps_Ul_i1ni File

The internal settings of the ODBC interface are specified in the Isps_Ul . ini file. The

parameters should be configured as follows:

= Protocol should be set to ‘1’ to enable debug on the interface.

= TimeZone provides a numerical value specifying the desired time zone.

= Source specifies the name of the ODBC connection configured in section 5.1.
= User and Password should be set to the login information for the ODBC connection.
= Interval defines the interval setting in minutes for grouping call data statistics.

The last four parameters in the Avaya ODBC section of the file are required for the historical
agent reports. These fields are not required for the historical splits/skills and VDN reports. The
IgnoreBreaks parameter should be set to ‘1’ if only the Agent login/logout report will be
supported. If the Agent workmode/AUX reason code report will be supported, then the
IgnoreBreaks parameters should be set to ‘0’. The other parameters should be configured as

shown below.

[GENERAL]
CallLastAutolmportDate=22.08.2003
CallAutolmportMode=2
CallAutolmportTime=06:00
CallAutolmportinterval=15
AgentLastAutolmportDate=22.08.2003
AgentAuto ImportMode=2
AgentAutolmportTime=06:30
AgentAutolmportinterval=15
NoAutolmportStartTime=
NoAutoImportEndTime=

Protocol=1
CallAutolmportintervalReferenceTime=00:00
AgentAutolmportintervalReferenceTime=00:00
AutomaticlmportForMissingDays=1
WriteAlways=0

[DB]
1=R4-System,0,admin,D2038D07FE62503015

[R4-System]
CallVersionld=101
AgentLevel 1d=5000

[Avaya ODBC]

Protocol=1

TimeZone=12

Source=CMS

User=cms

Password=XXXXX
Interval=30
IgnoreBreaks=0

LoadAl IAgentActivities=1
IncludeWorkmodeForAgent=1
MinimumActivityDuration=0
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5.3. Configure Master Data in InVision Enterprise WFM for Historical
Reports

This section covers the configuration of master data in InVision Enterprise WFM. Master data
includes external systems, planning units, queues, value types, contracts, employees, and
activities. To configure master data on iWFM, launch an Internet browser and enter the IP
address of the iIWFM server in the URL field. Log in using the appropriate “admin” credentials.
The webpage shown below is displayed. iWFM configuration is performed through the
AdminPro module of iWFM accessed by selecting the Administration option in the left pane.

£ InVision Enterprise WEM - Windows Internet Explorer |ZHE”Z|
@‘\-— |lr http: 192,168, 199,51 isps/plugins/logon V| 42 ([ X | | B2~
 — — ™ »
v [i ----- i IrWision Enterprise WEM l l fh - Bl = - |k Page - 0 Tools -
Tl License 1, InVision Software AG
!%y% IWFM Invision INTERNAL USE ONLY, 4.5.0
| L |
Forecasting
SRS Forecasting Scheduling
Time Management = Forecast = Capacitor = CampaignPro = Meeting Planner = Planning Periods

PP These modules will assist you when it comes to = Shift Center
Monitoring

determining future staff requirement. To achieve this, The modules in this area offer a solution for the
central issues in Workforce Management: Who does
what, when and where? These questions are

answered taking into account such critical factors as

" . the system will take historical data and compare it to
Administration 2 5
the current data, such as the number of employees,

the efficiency in use of resources and the vacation

periods. This way staff shortages and surpluses can staff requirement, scheduling rules, employee

be identified in time to make the necessary profiles, preferences and staff availability restrictions.

adjustments.
Monitoring Administration
= Reports = OnlineCockpit = Day Models = Planning Units = Employees

= AdherenceMonitor This is the module where you administer the master

These modules allow you to combine the data in your data, employee and user access rights, scheduling

system with data from external sources. Once you parameters as well as organisational and planning

have this new data you will be able to analyse and structures.
evaluate it.
9 & @ 2
[d € Internet F100% -
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5.3.1. Administer the External System for Avaya CMS

Before ACD call center data can be imported from Avaya CMS using the ODBC interface, an
external system must be added to iWFM to represent the Avaya CMS system. External systems
are defined in the AdminPro module of iIWFM. From iWFM, navigate to
Administration-> System->External Systems. Click on the “+” icon to add a new external
system. When adding an external system, set the System Description field to Avaya CentreVu
CMS and provide a descriptive name (e.g., Avaya ODBC). For the splits/skills and VDN reports,
enable the PhoneLink checkbox. For the agent reports, enable the TimeLink checkbox. Click

OK to submit the form.

InVision AdminPro/ External Systems

License 1, InVision Software AG
InVision INTERNAL USE ONLY, 4.5.0

Forecasting
Avaya ODBC

External System Awaya ODBC
rGeneral » System Connection

¥ General

Scheduling
Time Management
Monitoring

Administration

» Scheduling

b Forecasting

b Time Management
¥ System

Scheduling Rules
Settings

External Systems

Group Authorisation
User Authorisation

Password

System Description

Name |Avaya ODBC

Real Time Option ™

W System Connection
PhoneLink
TimeLink
StaffLink

OK

QulutrdssduSdie

Cancel
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5.3.2. Configure Master Data for Splits/Skills and VDN Reports

This section covers the administration of master data for the splits/skills and VDN reports.

5.3.2.1 Administer Queues

Create Queues for splits/skills and VDNs. Navigate to Administration—>Forecasting—> Queues
in AdminPro and provide a descriptive name and abbreviation for the split/skill. Enable the
Active checkbox. Click OK to submit the form. Repeat for each split/skill and VDN to be

monitored by iIWFM.

InVision AciminPro/ Queues

License 1, InVision Software AG
InVision INTERMNAL USE OMLY, 4.5.0

Queue Invision HG1

» General »Event Types »Value Types
Forecasting

¥ General
Invision HG1

Scheduling Invision HG2 Name |Tnvision HG1
SuperQueusRoot Abbreviation Invision HG1 ¢

Time Management

@ o |l 3|2

Active 17
Monitoring Interval
Description -
Administration _
» Scheduling Parent Queue [none
- .
Forecasting CEEr s £
Event Types
VP MName From To
Value Types .
. No entries are available.
Versions
-vae s %
Forecast Calendar Name Formula
wWeekly Distribution Curves No entries are available.
Scripts
Campaign Models _I
-
F Time Management =
4 : -

The following screen provides an example of a Queue configured for a VDN.

InVision AciminPro/ Queues

License 1, InVision Software AG
InVision INTERMNAL USE OMLY, 4.5.0

Queue Invision VDN1

» General »Event Types » Value Types

Forecastin
9 ¥ General

Invisicn HG1

Scheduling Teviichom BER Name [inwision von1

Abbreviation

Invision WVDN1 hd

Invision VDN1
Time Management

@ o |l 3|2

Invision VDN2 Active I
Monitoring SuperQueueRoot Interval
Description 7
Administration o
} Scheduling Parent Queue [ vone]
- .
Forecasting ~ Event Types *
Event Types
VP MName From To
Value Types .
. No entries are available.
Versions
- vate Ty 0
Forecast Calendar Name Formula
Weekly Distribution Curves No entries are available.
Scripts LI
Campaian Models 2
y . |
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5.3.2.2 Administer Value Types

Create Value Types corresponding to the call center data statistics imported by iWFM.
Navigate to Administration->Forecasting—>Value Types in AdminPro and provide a
descriptive name and abbreviation for each data item in the historical reports. These data items
are available from Avaya CMS through the ODBC interface. The figure below provides an
example of a value type for the ABNCALLS data item. Click OK to submit the form. Repeat
this step for each data item in the historical splits/skills and VDN reports.

1 B License 1, InVision Software AG
!%?% Admlnpro " Value Types InVision IrNTERNAL USE ONLY, 4.5.0
laj+|x Value Type ABNCALLS
» General
Forecasting e
ABNCALLS
Scheduling ABNCALLS1 Name .
ABNCALLS2 Abbreviation ABNCALLS @
Time Management
ABNCALLS3 Type @
Monitoring GENCAL 2 Description
ABNCALLSS o
Administration ACCEPTABLE &
} Scheduling ACOCALLS
ACDTIME
¥ Forecasting P —
Ewvent Types ANSTIME
Versions CALLOFFERED
Queues DISCCALLS
Forecast Calendar INCALLS
Weekly Distribution Curves INFLOWCALLS
Scripts 1_ACDTIME
Campaign Models I ACWTIME
b Time Management I_AUXTIME
~ System I_AVAILTIME
Scheduling Rules LA, S
. MAXOCWTIME
Settings
External Systems OB
Group Authorisation SETALCLIE-UE
User Authorisation RS ) J
Password —~
‘ I oK Cancel
@ o [ Q) »
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5.3.2.3 Map Value Types to Queues

Edit the Queue configured in section 5.3.2.1 for each split/skill and scroll down to the Value
Types section and map the value types configured in section 5.3.2.2 to this queue by clicking on
the “+” icon in that section. The figure below displays the value types relevant to the queue
associated with the splits/skills.

isi i License 1, InVision Software AG
!%!v% Adminpro " Queues InVision IrNTERNAL USE ONLY, 4.5.0

.Q, + X Queue Invision HG1

» General »Event Types »Value Types

Forecasting

— Abbreviation @

Invision HG1
Scheduling Invision HG2 Active &

Invision VDN1 L CICE =
Time Management S — Description "
Monitoring SuperQueueRoot hut

Parent Queue | [None] W

Administration w Event Types E
} Scheduling Name From To
¥ Forecasting No entries are available.

Ewvent Types

[#|

wJalue Types
Value Types

. Name Formula
Versions

acocaus

I_AVAILTIME

2 %

Forecast Calendar ABNCALLS z‘ !—I
Weekly Distribution Curves DISCCALLS é—l !—I
Scripts BUSYCALLS 7 %
Campaign Models I_ACDTIME z‘ !—I
b Time Management I_ACWTIME # %
+ System CUTFLOWCALLS Z %
Scheduling Rules INFLOWCALLS z‘ !—I
Settings OTHERCALLS Z %
External Systems ABNCALLS1 Z %
Group Authorisation ABNCALLSZ £—| !—I
User Authorisation ABNCALLS3 ;‘ !—I
Be=swor ABNCALLS4 7 %
ABNCALLSS 7 %

MAXOCWTIME 7 %

ANSTIME 7 %

I_STAFFTIME # %

2 %

2 %

2 x

2 %

I_AUXTIME
ACCEPTABLE
CALLOFFERED =
‘I I v - OK Cancel
ol @]
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Edit the Queue configured in section 5.3.2.1 for each VDN and scroll down to the Value Types
section and map the value types configured in section 5.3.2.2 to this queue by clicking on the
“+” icon in that section. The figure below displays the value types relevant to the queue

associated with the VDNSs.

InVision AdminPro/Queues

License 1, InVision Software AG
InVision INTERNAL USE ONLY, 4.5.0

Forecasting

Invision HG1

Scheduling Invision HG2

Invision VDN

Time Management P
Invision VDN2

Monitoring SuperQueueRoot

Administration

} Scheduling

¥ Forecasting
Event Types
Value Types
Versions

Forecast Calendar

Weekly Distribution Curves

Scripts

Campaign Models

b Time Management

¥ System
Scheduling Rules
Settings
External Systems
Group Authorisation
User Authorisation

Password

Queue Invision VDN1

» General »Event Types »Value Types

Qo] @]

¥ General
Name [nvision vDN1 |®
Abbreviation @
Active 2
Interval
Description -

=

Parent Queue | [None] w

W Event Types !—I
Name From To
No entries are available.

¥ \alue Types il
Name Formula
ACDCALLS 7 %
ABNCALLS Z %
DISCCALLS 7 %
BUSYCALLS Z X%
ACDTIME 2 %
ACWTIME 2 %
OUTFLOWCALLS 7 %
VDISCCALLS 2 %
OTHERCALLS 2 %
INCALLS 7 %
ABNCALLS1 2 %
ABNCALLS2 7 %
ABNCALLS3 7 %
ABNCALLS4 Z X
ABNCALLSS 7 %
ACCEPTABLE 7 %

E
OK Cancel
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5.3.2.4 Associate IWFM Value Types to Avaya CMS Data Items

Start the XLink application to associate the value types configured in iWFM in section 5.3.2.2 to
the data items available from Avaya CMS via the ODBC interface. The Isps_Ul.ini file
configured in section 5.2 is used by XLink. To start XLink, run the Isps_Uls.exe
application located in the C:\Program Files\InVision Enterprise WFM\Client
directory. The window shown below is displayed.

XLk
File Settings Wiew ¢

MELa G2

Interface 4 FM Dueue
-[[] Awapa ODEC

Assigned Yaluetypes

U

From the Settings menu option, select ODBC-Settings to configure the ODBC source and login
credentials as shown below.

ODBC-Settings X
for Lucent ChS Ok,
Source |EMS Cancel
|zer ||:m$ Test |
Fazzword |
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XLink displays the Avaya CMS data items available on the left and the iWFM value type on the
right. These sub-items are displayed by expanding the options on each side of the screen. To
associate an IWFM value type to a CMS data item, select the value type (e.g., ACDCALLS) and
then double-click on the corresponding data item in the Avaya ODBC side (e.g., ACDCALLS).
The association can be seen in the Assigned Valuetypes section of the window. Repeat these
steps for all value types under all splits/skills and VDNSs to be monitored by iWFM.

Eile 3Settings Wiew 7
MEL- & %
Interface i FM Qusue
=83 Avaya ODBC =29 R4-5pstem
+- 71 3 SupeueusRoat
+-q 2 =83 Inwizion HG
-2 3 [Ef:CDCALLS
=23 Split [B] 4BMCALLS
+-[C7 Calabrio skil 510 [3 DISCCALLS
+-[7 Calabrio skill 520 [ BUSYCALLS
+-[(7 Centralized Meszagin |_'ED| |_ACDTIME
+-[0 ICHE test B LACWTIME
-3 Invizion HG 1 [E] OUTFLOWCALLS
[ achoaLLs B INFLOWCALLS
[E) ABNCALLS [3] OTHERCALLS
[E DISCCaLLS [E ABMCALLSY
[ BUSYCALLS [2] ABNCALLS2
[E 1_aCOTIME [3] ABNCALLS2
B _acwTIME [2] ABMCALLS4
[ OUTFLOWEALLS [ ABMCALLSS
[B INFLOWCALLS [B Mex=0CwTIME
[2 CALLSOFFERED [2 ANSTIME
[Z] OTHERCALLS [E LSTAFFTIME
B aBMCALLS B 1LAwAILTIME
[E) ABNCALLS2 B I_AU=TIME
[E aBNCALLSZ [E| ACCEPTABLE
[2 ABNCALLS4 [2] CALLOFFERED
[E ABNCALLSS +- Irwision HG2
B Me=0CwTIME +-77 Irwision YD1
Aszzigned Valuetypes -0 Invision VDN2
Awaya ODBC: 2 SplitInYision HG 1:ACDCALLS
LM
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The next step is to generate the script for each association. To access this window, double-click
the valuetype on the iIWFM queue display. Click the Generate button to generate the script

automatically which is displayed in the Macro sub-window shown below.

Script: C:\Program Files\Iin¥ision Enterprise WFEMAClient\1.BAS

Azzigned Y aluetypes

Awana ODBC:2:5plitlnizion HG T.ACDCALLS

tacro

Rem Intizsion Software AG S
Remm F
Rem

Dim Ergebniz Az Long

Dim */ochentag Az Long
Rem Sonntag=1, Montag=2, ...

Dirn Minuten Az Long
Ferm von 0 - 1440

Dirn Paral &s Long P

Test
[CEees |

Generate
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5.3.3. Configure Master Data for Agent Login/Logout Report
This section covers the administration of master data for the Agent Login/Logout report.

5.3.3.1 Administer the Planning Unit

Create a planning unit to group employees and other master data. To define a planning unit,
navigate to Administration->» Scheduling=>Planning Units in the AdminPro module. Provide a
descriptive name and abbreviation for the planning unit and set the Interval field to the
appropriate value. Click OK to submit the form.

Tel - - - License 1, InVision Software AG
!%‘!’% Adminpro" Plannlng Unlts InVision INTERNAL USE ONLY, 4.5.0
| Y ESES Planning Unit Avaya Call Center
Colour |+Name » General » Business Hours » Activities » Day Models » User-Defined Parameters
Forecasting - » Cost Centre Parameters
| Avaya Call Center w General
Scheduling
Name [avaya call center |®
Time Management Abbreviation |avaya Call Center |®
Colour : :l
Monitoring
Interval ¢
Administration Number of Workplaces Ijl
¥ Scheduling Parent Planning Unit | [None] v|
Skills W Business Hours ._:I !—I
G walid From valid To Day Type From To
Day Models X X
No entries are available.
Week Time Patterns
Work Time Pattern Models ¥ Activities -_:I !—I |L|
Shift Sequences ‘I | L4
-
4 | ' OK Cancel
@ | & | fo |G
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5.3.3.2 Administer Contract

Create a Contract for all of the employees who will be scheduled in iWFM. Contracts contain
data about working hours, company regulations, and scheduling rules parameters that are
important for scheduling each individual employee. To add a contract, navigate to
Administration->Scheduling=>Contracts in AdminPro. Provide a descriptive name and
abbreviation for the contract and configure the other mandatory fields, indicated by a red bullet.
Click OK to submit the form.

Isi & License 1, InVision Software AG
!%\'EJ AdminPro/ Contracts InVision INTERNAL USE ONLY, 4.5.0
QU+ X Contract Basic Contract
Colour |~Name » General »Work Time Guideline » Working Hours for Each Day of the Week
- Cole - .
Forecasting + AutoScheduler Parameters » Scheduling Parameters » Overtime Factor
Bo=ic B+ Bonus Points Systems
Scheduling w General =
Name |Basic Contract A
Time Management
Abbreviation |Basic Contract |®
Monitoring Colour E
inistrat Working Daye per Week 70 W
Administration SR oL S 7.0 M
. Calculation of the Workdays ‘ Standard w |.
¥ Scheduling
Type of Employment ‘ Salaried Employee vl
Skills ~
Activities Target Work Time Calculation ‘ Contract v|
Day Models Previous Year's Vacation Invalid on
Week Time Patterns ¥ Work Time Guideline
Work Time Pattern Models X X
Minimum Target Maximum
Shift Sequences
Day | | | [ ]
Day Types
Planning Units s | i ‘ i | i
Planning Calendar Month | d | ‘ d | | d |
Selections Year | | ‘ i | C
ubutes W Working Hours for Each Day of the Week
Workplaces
. Monda
Bonus Points Systems M :l
Contracts Tuesday l:l
Maodulation Periods Wednesday l:l
— -
Employees T >
4] | »
bk Enrarac Hinn -
‘I I b OK Cancel
o ﬁ |]1 Q ~ Number of entries: 1
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5.3.3.3 Administer Employees

Add an employee corresponding to each agent in the call center. To add an employee, navigate
to Administration->Scheduling=>Employees in AdminPro. Provide a Personnel Number and
a Last Name. The First Name is optional. Click OK to submit the form.

Il'lvisiol'l License 1, InVision Software AG
Software InVision INTERMAL USE ONLY, 4.5.0

Selection [all] » General » » Availability »Skill Levels » Activities
ions » External Systems » Workplaces

osts » Time Management Rules

Forecasting ft Sequences »Se

+ Uni

» Flanning Units » Al
» Work Time Pattern Models

Colour |Personnel Number |~Name

entres

Scheduling m Agent 29101, _“| ¥ General
2 Agent 29102, L
Time Management | a . Personnel Number 1 |
[ ] 3 Agent 29103, User Name I ] »
Menitoring [ ] 4 Agent 20104, Password | |
R Ioin Date
Administration
Leave Date
¥ Scheduling :
Skills ¥ Personal Data ; ﬂ
Activities Valid From
Day Models Valid To
Week Time Patterns Title [Mone] ~
Work Time Pattern Models =t Nome |Avaya |
Shift Sequences Middle Name(s) | |
Day Types Last Name |agent 23101 &
Planning Units
Street [ |
Planning Calendar
Selections FasiEEE | |
Attributes City | |
Waorkplaces Telephone [ |
Bonus Points Systems Telephone 2 [ |
Contracts E-Mail [ |
Modulation Periods E-Mail 2 [ |
= | |
» Forecasting Marital Status unknown - d
-
4| | » OK Cancel
@ & |0 &) 2
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Scroll down to the Contracts section and map the contract configured in section 5.3.3.2 to the
employee by clicking on the “+” icon in that section. Next, map the Planning Unit configured
in section 5.3.3.1 to the employee.

isi H License 1, InVision Software AG
!%!v% Adm;npro" Employees Invision INTERNAL USE ONLY, 4.5.0

[ laj+|x
Availability » Skill Leve
Forecasting ing Units » Attributes  » Shift ¥ External System:
ime Pattern M
- a eau
Scheduling m Agent 29101, = ]
Schedule Position
ime M . m Agent 29102,
Ime Managemen
H : Agent 20103, | ¥ Contracts ) #
Monitoring - a Agent 29104, Valid From Valid To Contract
Basic Contract ;‘ g‘
Administration w Availability J ﬂ
¥ Scheduling Valid From Valid To Day Type From To
Skills No entries are available.
Activities
Day Models w skill Levels J E
Week Time Patterns valid From valid To Skill Level
Work Time Pattern Models No entries are available.
Shift Sequences - Activities
Day Types
. . Valid From Valid To Activity Suitability
Planning Units .
) Invision HG1 100
Planning Calendar X
Invision HGZ2 100
Selections
. Present 100
Attributes
Workplaces ¥ Flanning Units J E
Bonus Points Systems valid From valid To Planning Unit Priarity
Contracts Avaya Call Center 1 Q E
Modulation Periods ¥ Attributes ; E
Employees valid From  Valid To Attribute Value
) Forecasting No entries are available. j
-
‘l I 5 0K Cancel

L7 T IR L o R

Finally, scroll down to the External Systems section and map the external system configured in
section 5.3.1 to the employee as shown in the figure below.

Isi i Licenze 1, InVision Software AG
!%lv% Adminpro" Employees InVision INTERNAL USE OMNLY, 4.5.0

a4+ X Employee Agent 29101, Avaya

Selection [All] » General » Personal Data » Miscellaneous » Contracts b Availability » Skill Levels » Activities
Forecasting ¥ Planning Units ttributes b Shift Sequences » Selections ¥ External Systems » Workplaces
Colour |Personnel Number | ~Name » Work Time Pattern Models » Cost Centres  » Unit C

» Time Management Rules

Schedulin, i :
g Agent 2910 No entries are available.
Agent 291C

Time Management ¥ External Systems J !—I

Valid From valid Te External System  Employes ID in  Active

Agent 291C

oo

Monitoring Agent 291C

External System

4
Avaya ODBC 29101 Yes 2 %

=¥ -|

Administration
W \Workplaces

¥ Scheduling
4| I OK Cancel
@ | Id & 2
Repeat these steps for each agent in the call center.
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5.3.3.4 Administer Activities

Define Activities corresponding to splits/skills and VDNs. To add activities, navigate to
Administration->Scheduling=>Activities in AdminPro. Click on the “+” icon to add an
activity. The following screen shows the configuration of a split/skill as an example. Provide a
descriptive name and abbreviation for the activity and set the activity type to the appropriate
value. For the split/skill, the Type field is set to Presence. Click OK to submit the form.

Isi H = Licensze 1, InVision Software AG
!%!v% Adm;npro f ACINI']ES InVision INTERNAL USE ONLY, 4.5.0
X Actvity Invision HG1

» General » Third Farty Software » External Systems

+ Skills » Subactivities

Forecastin
9 » General =

] Invision HG1

Scheduling ] Invision HG2 Name [tnvision HG1 |
[ Present Abbreviation [tnvision HG1 |0
Time g
Colour
Monitoring Type | Presence R |.
Importance
Administration
Paid r
¥ Scheduling Comply With Rest Period r
=il Plannable r
Activities
R -
Day Models
Replaceable r
Week Time Patterns d
Waork Time Pattern Models Exchangeable r~ |
Shift Sequences Allow Overstaffing If Requirement 1= [
Day Types Zero
Planning Units Official Name | |
Planning Calendar Official Abbreviation [ |
e ¥ Third Party Software
Attributes

Mame for Third Party Software | |

Waorkplaces

Classification for Third Party Software

Bonus Points Systems -

‘I 5 OK Cancel
7 T8 R S O 8 I P
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In the External Systems section, map the external system configured in section 5.3.1 to this
activity. The iWFM ODBC interface creates system activities to which iIWFM activities can be
mapped based on the supplied configuration. Repeat these steps for each split/skill.

Soltware

InVision AdminPro/ Activities

License 1, InVision Software AG
InVision INTERNAL USE OMLY, 4.5.0

Forecasting

Activity Invision HG1

Comply With Rest Period [}

Invision HG1
Plannable

Week Time Patterns
Work Time Pattern Models
Shift Sequences

Day Types

Flanning Units

Flanning Calendar

Selections

@ | & e | B2

» General »Third Party Software » External Systems » Skills » Subactivities

Scheduling [ ] Invision HG2 r
Time Management - Present e 5
Replaceable [}
Monitoring Exchangeable I
Allow Overstaffing If Requirement Is [
Administration Zero
¥ Scheduling Official Name [
Skills Official Abbreviation [
¥ Third Party Software
ay Models

MName for Third Party Software [

Classification for Third Party Software

W External Systems i—l
Extarnal System Job ID Clazsification
Avaya ODBC 3-InVision HG 1 1 7 %
2

I Ok

Cancel

5.3.3.5 Map Activities to Planning Unit
Edit the Planning Unit configured in section 5.3.3.1. Map the Activities configured in section
5.3.3.4 to this planning unit.
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5.3.4. Configure Master Data for Agent Workmode/AUX Reason Codes
Report

This section covers the administration of master data for the Agent Workmode/AUX Reason
Codes report. This report requires all of the master data configured in section 5.3.3 and
additional Activities for workmodes and AUX reason codes.

5.3.4.1 Administer Activities

Define Activities corresponding to workmodes and AUX reason codes. To add activities,
navigate to Administration—=>Scheduling—=>Activities in AdminPro. Click on the “+” icon to
add an activity. The following screen shows the configuration of the ACD workmode as an
example. Provide a descriptive name and abbreviation for the activity and set the activity type to
the appropriate value. For the ACD workmode, the Type field is set to Presence. Click OK to
submit the form. In the External Systems section, map the external system configured in
section 5.3.1 to this activity. Repeat these steps for each workmode. The figure below displays
the workmodes and AUX reason codes configured for this test configuration.

isi i it License 1, InVision Software AG
!g% Adm"lapro ’{ Acuvmes InVision INTERNAL USE ONLY, 4.5.0
jaj+|ix

Forecasting

¥ General =
[ ] Present
i e N @
Scheduling m Invision HG1 ame ACD
= Abbreviation @
Time Management - Invision HG2 ACD
B Lunch Colour — - |
Monitoring B Treining Type Presence | -*
[ ] Meeting Importance 100.00
Administration .
[ | Break Paid I~
¥ Scheduling [ ] Default-AUX Comply With Rest Period I~
Skills [ ] RING Plannable r
Activities
ay Models
| DACD Replaceable I
Week Time Patterns e
. ACW
Work Time Pattern Models - Exchangeable r
Shift Sequences | ACD Allow Overstaffing If Reguirement Is [
Day Types [ ] OTHER Zero
Planning Units || AVAIL Official Name
Planning Calendar Il | TRACE-ON Official Abbreviation
Selections [ | TRACE-OFF W Third Party Software
Attributes UNKNOWN
Worknl L Name for Third Party Software
orkplaces [ | b
Bonus Points Systems Classification for Third Party Software |1 %
Contracts W External Systems &
Modulation Periods External System Job ID Classification
Employees Avaya ODBC 3-ACD 1 2 %
b Forecasting o
-
b Time Mananement
4 » OK Cancel
@ || Q|»
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AUX reason codes are also configured as activities. The following screen shows the
configuration of the Training AUX reason code as an example. Some AUX reason codes, such
as Break and Lunch are configured with a Type of Break.

q
2 L R E L R R

31 : PR Licenze 1, InVision Software AG
m AdminPro/ Activities InVision INTERNAL USE ONLY, 4.5.0
fap+|x Activity Training
- » General »Third Party Software » External Systems » Skills » Subactivities
Forecastin Colour |Name
9 W General =
[ ] Present
- T .
Scheduling = ot e Name [Training |
e Abbreviation |Trair1ir1 |.
I HG2 g
Time Management - nvisien
[ ] Lunch Colour EI
Monitoring ] Training Type | Presence et | 4
[ ] Meeting Importance 100.00
Administration A
[ | Break Paid -
¥ Scheduling [ Default-AUX Comply With Rest Period I
SEiE [ ] RING Plannable r
Activities
| actviies [y Requestable =
Day Models
| DACD Replaceable I~
Week Time Patterns .
. ACW
Work Time Pattern Models - Exchangeable r
Shift Sequences | ACD Allow Overstaffing If Requirement Is [
Day Types Il OTHER Zero
Flanning Units [ | AVAIL Official Name | |
Planning Calendar Il  TRACE-ON Official Abbraviation | |
Selections [ | TRACE-OFF W Third Party Software
Attributes UNKNOWN .
- Name faor Third Party Software [ |
Workplaces e
Bonus Points Systems Classification for Third Party Software
Contracts W External Systems !—I
Modulation Periods External System Job ID Classification
Employees Avaya ODBC 3-Training 1 Q il
} Forecasting |
-
F Time Mananement
OK Cancel

5.3.4.2 Map Activities to Planning Unit

Edit the Planning Unit configured in section 5.3.3.1. Map the Activities configured in section
5.3.4.1 to this planning unit.
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6. Interoperability Compliance Testing

The interoperability compliance test included feature testing focused on verifying the ability of
InVision Enterprise WFM to import ACD call center data from Avaya CMS using the ODBC
interface and displaying splits/skills, VDN, and agent data on iWFM Shift Center and
OnlineCockpit.

6.1. General Test Approach

The feature test cases were performed manually. Incoming calls were made to the monitored
splits/skills and VDNSs to generate call center statistics to be imported into iWFM. In addition,
agent activity was generated for the historical agent reports. The verification of all tests included
checking the proper display of historical splits/skills, VDN, and agent data in iWFM, including
data accuracy.

6.2. Test Results
All test cases were executed and passed.
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7. Verification Steps

This section provides the tests that can be performed to verify proper configuration of Avaya
Communication Manager, Avaya Call Management System, and InVision Enterprise WFM.

7.1. Verify Avaya Communication Manager

Verify the status of the processor interface channel by using the “status processor-channels n”
command, where “n” is the processor channel number from Section 3.6. Verify that the Session
Layer Status is “In Service”, and that the Socket Status is “TCP connected”, as shown below.

status processor-channels 1
PROCESSOR-CHANNEL STATUS

Number: 1
Status: In Service
Socket Status: TCP connected
Link Number: 2
Link Type: ethernet
Message Buffer Number: O

Channel
Session Layer

Last Failure: Far end sent disconnect message
At: 03/31/08 15:04

Verify the status of the TCP/IP link number by using the “status link n” command, where “n” is
the TCP/IP link number assigned to the C-LAN used to connect to the Avaya CMS server from
Section 3.5. Verify that the Link Status is “connected”, and that the Service State is
“in-service/active”, as shown below.

status link 2 Page 1 of 5
LINK/PORT STATUS
Link Number: 2
Link Status: connected
Link Type: ethernet
Link Name: Clan2
Service Port Location: 02A0217
Service Port Data Extension: 24981
Service State: in-service/active
Node Name: clan2
Source IP Address: 192.45.100.70
Subnet Mask: 255.255.255.0
Broadcast Address: 192.45.100.255
Physical Address: 00:04:0d:4b:28:08
Enabled? yes
Maintenance Busy? no
Active Channels: 1
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7.2. Verify Avaya Call Management System

From the MainMenu, verify the status of the connection to Avaya Communication Manager by
selecting Maintenance = Connection Status, as shown below.

) Avaya Terminal Emulator - CMS1924512050 s
Profle Edit Connection Help N
5/22/08 05:41 Avaya(TM) CMS Windows: 0 of 10 gl :J

Reports>
lonary>
ceptions>
nt Administration>
Center Administration>

L T b o e EEE——

Maintenance>
e \ 1T,

/Bestore Devices
Printer Administr on

tus

Zdmin Log Report
Error Log Report
e

|
|
|
|
| Connection Status ]
|
|
|

Help Window Cammands Feep Exit Scroll Current kainkdent
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Enter the corresponding ACD(s) number. For the compliance testing, the corresponding switch
connection is ACD system “3”. Tab over to Find one and press Enter.

Avaya Terminal Emulator - CM51924512050

e

Profle Edit Connection Help
9/22/08 05:44 Avaya(TM) CMS

Maintenance: Connection Status

Help Window Cammands Keep

Exit

Windows:

Scroll

1 of 10

Current

hll ACD=
Find one
List all
Next
Frevious

hainkdenu

The switch connection status is displayed. Check the status in the Session and Connection

fields, as shown below.

Avaya Terminal Emulator - CM51924512050

Profle Edit Connection Help
9/22/08 05:43 Avaya(TM) CMS

Maintenance: Connection Status

normal

1 matches found

Windows:

1 of 10

Help Window Commands Keep Exit Scroll Current Mainkdenu
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WEM\Server directory using Windows

1se

Enterpr

1SiIoNn

les\InVi

\Program F
Explorer and double-click on the Isps_Uls.exe application. The window shown below is

displayed and updates in real-time as data is being imported via the ODBC interface. Note that

data can be imported on an on-demand basis or automatically at pre-defined intervals.

To run the Avaya CMS ODBC interface on InVision Enterprise WFM, navigate to the

7.3. Verify InVision Enterprise WFM
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All of the historical reports can be imported on-demand or automatically at pre-defined intervals.
The import settings are configured by selecting Settings—> Auto-Import Settings from the

XLink window shown in section 5.3.2.4. The figure below shows the configuration for a
manual import.

Auto-Import Settings gl
Import Call Data
" |mport current data every minutes, Feference time |00;00 EI: [Realtime Option) Cancel

" Import previous day's data daily at |06:00 EI:

Import Agent Activity Data

" Impaort current data every minutes. Reference time [00:00 3: [Realtime Option)

" Import previous day's data daily at |06:30 3:

*+ Mo automatic import

If iWFM is configured for manual data imports, then an import can be triggered by selecting
File=>Start Import from the XLink window. The following Import call data window is
displayed. Specify the Start and End date for the report and then click OK.

Historical Import E|
Import call data
Date Cancel
Start | 9/22/2008 = |
End | 3/22/2008 -]
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In addition, a data log file is created in the C:\Program Files\InVision Entperise
WFM\Auxi I lary\Logs directory that contains the raw data imported by iWFM from Avaya
CMS. The following log contains the data imported for the splits/skills report.

09/22/08 22:07:56 >

SELECT ROW_DATE, STARTTIME,
INTRVL,ACDCALLS ,ABNCALLS,DISCCALLS,BUSYCALLS,1_ACDTIME, 1_ACWTIME,OUTFLOWCALLS,

INFLOWCA

LLS, CALLSOFFERED, OTHERCALLS , ABNCALLS1 , ABNCALLS2, ABNCALLS3, ABNCALLS4 , ABNCALLSS5 , MAXOCWT I
ME,ANSTIME, I _STAFFTIME, I_AVAILTIME, I_AUXTIME,ACCEPTABLE FROM hsplit WHERE ( ROW_DATE
BETWEEN {d "2008-09-22°} AND {d *2008-09-22"} ) AND SPLIT = 280 AND ACD = 3

09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08
09/22/08

1600;30;12;7;0;0;226;37;1;0;20;

22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57
22:07:57

V

VVVVVVVVVVVVVVVVVVVVVVVVVVVYVYVYVYV

>

09/22/08 22:07:57 >
09/22/08 22:07:57 >

0;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
30;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0

100;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
130;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
200;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
230;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
300;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
330;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
400;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
430;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
500;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
530;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
600;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
630;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
700;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
730;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
800;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
830;30;0;0;0;0;0;1800;0;0;0;0;0;0;0;0;0;0;0;1800;0;0;0
900;30;2;1;0;0;1;420;0;0;3;0;1;0;0;0;0;2;3;1800;1378;0;2
930;30;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;1800;1800;0;0
1000;30;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;1800;1800;0;0
1030;30;3;3;0;0;4;8;0;0;6;0;3;0;0;0;0;2;4;1800;1781;0;3
1100;30;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;1800;1769;31;0
1130,30;8;7;0;0;80;0;0;0;15;0;2;1;1,1,1,55 46;1800;1533;0;8
1200;30;7;3;0;0;104;0;0;0;10;0;3;0; ;0;77;89;1698;1558;10;6
1230,30,0;0;0,0,0;O;O;O;O;O;O;O;O;0,0,0,0 1800;1800;0;0
1300;30;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;1800;1800;0;0
1330;30;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;1800;1800;0;0
1400;30;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;1800;1800;0;0
1430;30;1;0;0;0;8;64;0;0;1;0;0;0;0;0;0;1;1;1770;1574;71;1
1500;30;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;0;1800;1800;0;0
1530;30;3;1;0;0;29;46;0;0;4;0;1;0;0;0;0;2;4;2053;1824;76;3
1;4;1;1;1;0;37;56;1861;1352;117;11
1630;30;1;1;0;3;28;0;0;0;5;3;0;1;0;0;0;18;1;586;555;2;1

END AFTER 34 ROWS.
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The log file below shows the data imported for the VDN report.

09/22/08 22:07:50 > SELECT ROW_DATE, STARTTIME,

INTRVL, ACDCALLS,ABNCALLS,DISCCALLS,BUSYCALLS,ACDTIME,ACWTIME,OUTFLOWCALLS,VDISCCALLS,O
THERCALLS, INCALLS ,ABNCALLS1,ABNCALLS2,ABNCALLS3,ABNCALLS4 ,ABNCALLSS,ACCEPTABLE FROM
hvdn WHERE ( ROW_DATE BETWEEN {d "2008-09-22"} AND {d ®"2008-09-22"} ) AND VDN="38000"
AND ACD = 3

09/22/08 22:07:50 > 900;30;2;1;0;0;174;28800;0;0;0;3;1;0;0;0;0;2
09/22/08 22:07:50 > 1030;30;3;3;0;0;4;8;0;0;0;6;3;0;0;0;0;3
09/22/08 22:07:50 > 1100;30;0;0;0;5;0;0;0;0;5;5;0;0;0;0;0;0
09/22/08 22:07:50 > 1100;30;0;0;3;0;0;0;0;0;3;3;0;0;0;0;0;0
09/22/08 22:07:50 > 1130;30;8;7;1;0;80;0;0;1;1;16;1;2;1;1;1;8
09/22/08 22:07:50 > 1200;30;5;2;0;0;24;0;0;0;0;7;2;0;0;0;0;5
09/22/08 22:07:50 > 1200;30;0;0;0;1;0;0;0;0;1;1;0;0;0;0;0;0
09/22/08 22:07:50 > 1200;30;2;1;4;0;80;0;0;4;4;7;1;0;0;0;0;1
09/22/08 22:07:50 > 1430;30;1;0;0;0;8;64;0;0;0;1;0;0;0;0;0;1
09/22/08 22:07:50 > 1530;30;3;1;0;0;29;46;0;0;0;4;1;0;0;0;0;3
09/22/08 22:07:50 > 1600;30;1;0;0;0;1;0;1;0;1;2;0;0;0;0;0;1
09/22/08 22:07:50 > 1600;30;0;0;3;0;0;0;0;3;3;3;0;0;0;0;0;0
09/22/08 22:07:50 > 1600;30;11;7;6;0;225;37;0;6;6;24;3;2;1;1;0;11
09/22/08 22:07:50 > 1630;30;1;1;1;3;28;0;0;1;4;6;0;0;1;0;0;1
09/22/08 22:07:51 > END AFTER 14 ROWS.

To view the splits/skills report in the iWFM OnlineCockpit, navigate to the OnlineCockpit
from the iIWFM window displayed in section 5.3. From the OnlineCockpit, drag and drop the
data items in the left pane into the right pane. The following window displays an example of a
historical report for splits/skills.

Tk = - License 1, InVision Software AG
!I!‘{IEIPI! OnlineCockpit InVision INTERNAL USE ONLY, 4.5.0
) X ) B B ] B [None] =l ==
View Intraday values v No name =
Start Date | 22/09/2008 X | 2200 -
" Compare Dates 2000 03:30 0.00 0.00 0.00 0,00 0.00
8 ien e 2 e . - - - - -
=W ABNCALLS iy 500 000 [T 000 0o 000
*  Historic 5
) 1400 530 0 non 0 o 000
® Actual Version B 05:00 0.00 0.00 0.00 0.00 0.00
<1 ABNCALLST 06:30 0.00 0.00 0.00 0.00 0.00
- HBNCALLS2 1000 07:00 0.00 0.00 0.00 0.00 0.00
+- ABMNCALLS3 800 07:30 0.00 0.00 0.00 0.00 0.00
S8 ABNCALLSS [ 000 [ 000 0 000
500 -
S . - - - - -
400 : L i |
G SR o (D] 000 000 000 0o 000
@ ALDCALLS 10:00 [ 000 [ 000 000
<1 ENSTIME I e 10:30 300 3.00 300 4,00 0.00
+- W BUSYCALLS CHN - B 1100 00 non 0 o 000
+-® CALLOFFERED == =2 = = = - o=ooo 11:30 7.00 &.00 500 46.00 0.00
<18 DISCCALLS 12:00 300 600 7.00 53 00 000
S8 INFLOWCALLS .Inwsinn HG1 ABMCALLS (hist) - 2] Invision HG1 ACCEFTABLE (hisf) 12:30 000 000 000 000 0.00
& LATDTIME Invision HG1 ACDCALLS thist) - 2 rvision HG1 ANSTIME (hist) - 2210 L L - L = i
ol — 1530 000 [ 000 0 000
= Invision HG1 BUSYCALLS thist) - [l invision H31 CALLOFFERED thist 1400 0.00 0.00 0.00 0.00 0.00
@ |_AURTIME 1430 000 100 100 100 000
B _AVAILTIME [lirvision HG1 DISCCALLS ¢histy - S Invision HG1 INFLOWCALLS thist Em g T i o oo
+1- W LSTAFFTIME Invision HG1 OUTFLOWGCALLS (hi Invision HG1 |_AGDTIME (hish - 2; 15:30 100 300 300 400 0.00
+1 B MAXOCWTIME 16:00 700 1100 1200 56.00 000
¥ ® OTHERCALLS Irwisian HG1 |_ACWTIME chisti- 2| Imision HG1 I_ALRTIME (hist - 22 1530 100 100 100 100 300
1700 000 000 000 0 000
él LA (A7 | Ilrvision HG1 I_AVAILTIME thists - Jljimvision HG1 |_STAFFTIME thist) - T = = = o =
+ Invision HG2
41 [ Ivision YON1 Invigion HG1 MAXOCWTIME (his)  Invision H31 OTHERCALLS (hist) LY i 00 i uay | =
T oo o oo Ao o
+ [ Irwision VONZ - < »
9 o b & .~
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The following window displays an example of a historical report for VDNSs.

1 : - License 1, InVision Software AG
!IIT!'% OnlineCockpit InVision INTERNAL USE ONLY, 4.5.0
& | X B e = [Nane] v =1 i) =4 =)

View Intraday values | | No name
Start Date ZZ/'UQ/ZUDEH 240

[” Compare Dates 230
=12 Queues

+1 20 Invision HG1 200

+1-[3 Invision HG2

=14 Invision VDN1 180

=@ ABNCALLS T
®*  Historic
*  fctual Version 140
+ @ ABNCALLST
+- @ ABNCALLS2 120
+ @ ABNCALLS3
B ABNCALLSS iy
+ @ ABNCALLSS @
+- @ ACCEPTABLE
+ @ ACDCALLS &0
+- 8 ACDTIME
+ @ ACWTIME 0
+- 8 BUSYCALLS
+- @ DISCCALLS £l
+ B INCALLS oLl |:1—|:: mlE==
+ @ OTHERCALLS 2 &2 8 8 8 8 8 &8 &8 &8 8 8 8 8 21:30 0.00 0.00 0.00 0.00 0.00
+ @ OUTFLOWCALLS S - - & 2 o2 & £ 2 2 " 8 & 8 22,00 0.00 0.00 0.00 0.00 0.00
+-8 VDISCCALLS 22:30 0.00 0.00 0.00 0.00 0.00
+ [ Invision YDN2 [lrvvision VON1 ABNCALLS thist) - 2209/20 [ Invision YON1 ABNCALLS1 ihist) - 220912 20:00 .00 .00 400 .00 .00
(3 Supertiueuefioot 2330 0.00 000 000 0.00 0.00
) Invision VON1 ABNCALLE? thist) - 22/092 [llirvision VON1 ABNCALLE? thist) - 220972
+-[= Planning Units
Invigion VON1 ABMNCALLS4 thist) - 220092 [[llirvision VDIN1 ABNCALLSS thist) - 22100/2
[l rvision VDN1 ACCEPTABLE (hist) - 2209 llnvision VDN1 ACDCALLS (hist) - 22/08/20
Invigion VON1 ACDTIME thist)- 22/09200F Invision VDM1 ACWTIME (hist) - 22/08/2001
Invision VDN1 BUSYCALLS thist) - 2208727 Invision VDM1 DISGCALLS (hist) - 2208120
[l rvision VON1 INCALLS thist) - 22092006 llirvision vON1 OTHERCALLS ihist) - 22109
Invigion YON1 OUTFLOWICALLS thisti- 22 Invision YDM1 WDISCCALLS (hist) - 22/097
< »
@ || |& |2
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To view the agent login/logout report in the SchedulePro module of iWFM, navigate to
SchedulePro->Shift Center. The list of employees (i.e., agents), along with their login and
logout times, is displayed.

Li 1, InVisi Soft AG
InVision SchedulePro/ Shift Center e e

09
Forecasting

Schedulin:
9 Agent 29101, Avaya Schedule
w SchedulePro Actual
DesiiCe et Actusl Irvision HG1 13:08 - 12:09
Planning Periods External Sy Inwizion HGET 13:10 - 19:.04
Closi 3 d Aoert 29103, Avaya ) Schedule
osing Periods e
Meeting Planner External Sy
Insert Shift Sequences Aoert 29104, Svaya 4 Schedule
Employee Requirement L]
et i External Sy
Shift Requirement
acation Entitlement
Approve Exchange
Requests
b Infothek Interactive
Schedule
_
b TrainingPlanner < S

Time Management E| ‘

Q| & Qo2

If the agent workmodes and AUX reason codes are also imported (as indicated by the
IgnoreBreaks parameter being set to ‘0’), the agent status report is viewed the same way as the
login/logout report.

= License 1, InVision Software AG
!%‘,".—‘“! SchedulePro / Shift Center InVision INTERNAL USE GNLY, 4.5.0 ‘
je)st IR Al v
d ~
Forecasting E|
FEIEIIY Agent 29101, Avaya 1 Schedule
+ SchedulePro Actual
Shift Center
= posit 2210 ere 2 Schedile Trvvision HGT 13,07 - 1308 [00.00 hl |—
sl Actual Irwision HG1 12:08- 1309 [00:01 k) |
Planning Periods External Sy Inwvision HG1 13:09- 1552 (0243 h) |
Agert 29103, Avaya 3 Schedule Invision HG1 15:53 - 15:57 [00:04 h]
Closing Periods e AYAIL 1557 - 16:41 (0043 1) —
RING 16:41 - 18:41 (0000 h) —
Meeting Planner Exernal Sy DACD 16:41 - 16:41 (0000 h] |
Insert Shift Sequences Agent 29104, Avaya 4 Schedule BVAIL 16:41 - 16:45 (00003 h)
| ) Actual DTHER 16:45 - 16:45 (00:00 h)
Employee Requirement Edernal 5y Default-A0% 16:45 - 16:45 (0000 k] [
Shift Requirement AYAIL 16:45 - 16:45 (00:00 k) —
) i RING 16:45 - 18:46 (00:00 h)
‘Vacation Entitlement ACD 16:46 - 16:46 [00:00 h]
ACW 16:46 - 16:47 (0000 k)
T BIL 16:47 - 16:47 (0000 h)
g Lunch 16:47 - 16-47 [00:00 ]
: AVAIL 1647 - 16:47 [00:00 k)
o I”fgtge'l( Interactive FING 15:47 - 16:47 (0000 h)
Schedule DACD 16:47 - 16:48 [00:00 b 3
DACW 15:48 - 16:48 [00:00 k) =
b TrainingPlanner S AL 1E:48 - 16:48 (0000 h) 3
RING 16:45 - 16:48 (0000 )
= AVAIL 1648 - 1E52 (0003 k)
Time Management RING 16:52 - 16:52 (00:00 ]
ACD 16:52 - 16:52 [00:00 b
DTHER 16:52 - 16:52 (00:00 h)
ALCD 16:52 - 16:52 (00:00 b
@ £ Dq g A Irwvision HG1 16:52 - 20:50 [03:58 h)
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8. Support

Contact InVision Software for technical support on iWFM via web or phone.

=  Web: www.invisionwfm.com
= Phone: Check http://www.invisionwfm.com/uk/enguk/about invision/offices for contact
information

9. Conclusion

These Application Notes describe the configuration steps required for InVision Enterprise WFM
to successfully interoperate with Avaya Communication Manager using the ODBC interface of
Avaya Call Management System. All feature and serviceability test cases were completed
successfully.

10. References
This section references the product documentation relevant to these Application Notes.

= Administrator Guide for Avaya Communication Manager, Document 03-300509, Issue
3.1, February 2007, available at http://support.avaya.com.

= Avaya Call Management System Switch Connections, Administration, and
Troubleshooting, Document ID 07-601582, February 2006, available at
http://support.avaya.com.

= AdminPro User Manual for InVision Enterprise WFM, Release 4.5.0a, Edition November
1, 2007.

= OnlineCockpit User Manual for InVision Enterprise WFM, Release 4.5.0a, Edition
November 1, 2007.

= SchedulePro User Manual for InVision Enterprise WFM, Release 4.5.0a, Edition
November 1, 2007.
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